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1 About this guide

This manual is based on eTools version 2.0. It describes how to install and use the eTools

application.

In this manual,

e User refers to the person at the utility using the eTools program
o Customer refers to the person who has meters installed to measure energy consumption.

The guide is divided into the following main chapters:

Topic

Description

eTools: Network
Management System

Provides an overview of the eTools software.

Start using eTools

Provides instructions for installing and starting up the program,
including descriptions of Login, Logout, Refresh, Progess bar,
GSM connection to concentrators and user management.

Import

Contains descriptions of the import function in the File menu.

media

Concentrator connection

Contains descriptions of how to set up and test the concentrator
connection.

Project navigation

Contains descriptions of how to navigate through the program.

Concentrator tasks

Contains descriptions of the concentrator tasks.

KML Viewer export

Contains description of the export in KML format for using KML
Viewer as geographical view.

Project handling

Provides guidelines on how to start up a project and continuously
move parts of the project to the AMR readings server.

Additional information

This topic describes where to find additional information.

The following typographical conventions are used in the guide:

Typography | Description

Bold Text that appears in the user interface is written in bold style.

= An = (arrow symbol) between pieces of text, e.g. File menu = Print, means
that you should first select File menu and then select Print.

1.1 What's new?

The following new features are introduced with eTools 2.0:

e ltis now possible to change your eTools password. For details, see Change password.

¢ New user management features have been introduced that let you create and delete users,
grant and revoke administrator rights and reset passwords. For details, see User

Management.
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2 eTools: Network Management System

eTools is a tool made for building up and administrating a Kamstrup radio network.

In eTools, it is possible to show status and quality of communication units and have a complete
overview of all units in a project.

Together with Kamstrup hardware, e.g. concentrators, eTools can initiate different kinds of tasks,
changing network structure and starting analysis in the network.

eTools is a building tool used to build up a network, making it ready for meter readings through
other programs, e.g. PcBase lll.

<
B eTools - salg-dk-udv - -“p- LI_IéJ:' E]
File Tools View Help
=}
=]
Na\ﬁ?aﬁnn View -7 ‘W Concentrator View . [J] Meter View | @ RouterView | Network View - x||Details bl
=% Demo Stage B : A Area Details
2PN Elccricety test il Network Information Address . -
& . . Name Electricety test wall
W 3830 Status Meter Number Meter Type WGES84 Longitude WGSBS Latitude Customer Long
= <> Heat test wall @ Bl _ Bl _ _ Concentrators
7858 3 Unreschable 11377319 Unknown 10,004096 56,069544 inoosnss ||V
a Good 11377320 3g2ne2 10,004337 56.,070037 10,004337 Units
|l Good 11377321 32162 10,006825 56070371 10,006825 Meters Routers
a Good 1377322 3g2ne2 10,007017 56,070246 10007017 F Do
al Good 11377323 3gane2 10,007166 56070127 10,007166 o =0
L A
do @0
X X0
e &0
Total : & Total : 0
Notes:
Tasks -~ 3

Concentrator Tasks

L

Kamstrup radio network consists of different components with built-in radio modems. The
communication frequency is within the 433 MHz band. Kamstrup can deliver components that use
license free frequencies and components that require a license.

The main function of a radio network is to read Kamstrup energy meters from a central computer
without any manual handling. To do this in a cheap and fast way, the user can build up small
networks that can read meters simultaneously.

The main components in a network are:
e Concentrators: central collecting units
e Routers: communication stepping stones for transferring data
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e Meters: energy calculators with numerous registers.

Reading meters in the network is basically done by the central AMR system that orders meter
registers in the different concentrators. After the registers have been ordered, the concentrator
starts collecting meter registers to its memory. It uses routers to send radio messages in up to 10
steps in order to reach all meters. When data has been collected, the AMR system fetches the
data from the concentrators to its central database. What kinds of registers that are read can be
individually controlled from the central system.

The Kamstrup radio network is optimised for low power communication. This means that the
network can be based on battery components that reduce the cost of power supply wiring. Using
battery components is, however, reducing the maximum reading frequency to 1 reading per month
to keep the specified lifetime.

2.1 Components in the network

The concentrator is the central unit that controls all communication in the network. lts main feature
is the network list. The network list is a list of the all units that the concentrators can read and use
for communication. The list consists of communication links between units in the network. This
means that without a network list, the concentrators do not know where to send radio messages
when reading meters.

Concentrator +
hodem

Routers _.
= g

Hetee @ ‘gé/ \./

The connection from the central AMR system to the concentrator can be made in different ways. In
principle, the concentrator has a serial interface that can connect to different kinds of modems.
Most common is a GSM/GPRS modem that is very easy to handle. But Kamstrup A/S can also
deliver built-in IP modems or other modems that have a serial interface.

Routers can be standalone units or integrated in meters. An integrated router means that the meter
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has routing functionality, and the need for external routers in the network is lowered. A typical
network with external routers (no integrated routers) uses 1 router per 4-5 meters. The number is
dependent on the placement of routers and the distance from router to meters. Please read the
installation guidelines for installing network components.

As the network list constitutes the central information in the concentrator, the eTools program's
central functionality is to analyse and edit the list in order to configure the concentrator with the
information needed. The concentrator has a set of instructions that eTools uses in order to analyse
links and improve the network quality, in the following called tasks. One example of a task is that
eTools defines which meters the concentrators should be able to reach, and then starts a meter
search function in the concentrator.
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eTools

3 Start using eTools

See the following sections for information on how to start using eTools:

e Program set-up

e Login
e Logout

e Refresh data

e Progress bar

e GSM connection to concentrators
e User management

3.1 Program set-up

eTools is a client/server program that uses a central database and communicates via web
services over the internet. Therefore, it is a prerequisite that the user has internet access when

using the program. This makes it possible to access the project from different computers that have

the program installed.

In order to install the program, click the installation link in the email that you received from
Kamstrup:

(o [ s B L N s eTools user created - Message (HTML) = | B %

-

3 }J $ x _3 Move to Folder = F@. Block Sender ED Categorize - = =)
. _ Lﬁ' Create Rule ﬁ; Safe Lists = ¥ Follow Up ~

R Eilﬁ Forward || Delete 2] Other Actions - ] Mot Junk j Mark as Unread Flfd
Respond Actions Junk E-mail = Cptions P
From: noreply @hosting-kamstrup. com Sent: Wed 02,09,/2015 13:23
Tae Peter Smith
Cc
Subject: eTools user created

— ﬁ —
—j Message Insert Options Format Text Adobe PDF L7

En] » &

“@pﬁ:ﬂl?llﬁ.0.11EJ-"SSW,-"Smar‘tclient,-"publi&h.a&@
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Choose Install and accept the download of the program:

eTools

[ =lE = |
[ )(-)| B https/etoolsk. ~ @ B & X || @ eTools-Ssw x Yo &8
File Edit View Favorites Tools Help x ﬁgConvert - B0 Select

x>

= Google Mgram Viewer

ﬁvvm@v

»

Page = Safety > Tools = @v

Name: eTools-S5W
Version: 2.0.12.0
Release date: 2015-09-11
Publisher: Kamstrup A/S

The following prerequisites are required:

« Windows Installer 3.1

« Microsoft .MNET Framework 4

Install

eTools-SSW

(x86 and x64)

Click the install button below to install the prereguisites and run the application.

ClickOnce and .NET Framework Resources

#100% -

i

The program is started in Windows by clicking Start = Programs = Kamstrup => eTools or
using the shortcut generated on the desktop.
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3.2 Login

When logging in to each project, the user needs to type in a user name and password. This login
information is granted by Kamstrup A/S when a project is registered.

i~ !

¥ LogOn = | [= 28

Username :  JohnSmith

Password : esessssssss

., A

The login gives access to each individual project. It is possible to change the password and to
create more users accessing the same project.

3.2.1 Change password

Follow the steps below to change your password:

1. Choose Tools menu = Change password.

/' Change Password = B X
Cld Password TITITTTII T,
NE';".I' F'ES.SW:lrlj SRS BB RN EREES

Repeat New Password  esesssssssssss

@| Cancel |

L ~

2. Enter the old password and the new one twice. Click OK.

Your password has now been changed.

3.3 Logout

The user can log out of the program by shutting it down or choosing Logout under the File menu.
Using the File menu to log out allows the user to log in again directly.

3.4 Refresh data

Any changes made in the network are being stored in a central database. This means that several
clients can access the same project simultaneously. If the user wants to update the client with
data according to the contents of the central database, it is possible to refresh data. Data is always
being automatically refreshed at start-up. Manual refresh can be done from the File menu or using
the shortcut in the top of the window.
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eTools

3.5 Progress bar

Communicating with external systems (network or databases) can be monitored in the Progress
Details window. The window appears automatically when the client is communicating and gives a
description of the progress. The Progress Details window will disappear automatically if:

The checkbox Auto Close when done is ticked
No error occurs during the communication.

Otherwise, the progress will be visible until Close is clicked. The last progress can be recalled in
the menu View — Progress Log.

i N
Progress — ———

E] Progress Details

Time Message

30:05-2011 11:13:38  Load Data completed.

{an, | »

,E" 30:05-2011 11:13:38  Applying 3 updated Routers to cache.
30052011 11:13:38 3 Updated Routers loaded.

30-05-2011 11:13:38  Applying 5 updated Meters to cache.
30-05-2011 11:13:38 5 Updated Meters loaded.

30:05-2011 11:13:38  Applying 2 updated Concentrators to cache.
@ 30:05-2011 11:13:38 2 Updated Concentrators loaded.
30:05-2011 11:13:37  Applying 2 updated Areas to cache.

@ 30:05-2011 11:13:37 2 Updated Areas loaded.

E 30:05-2011 11:13:37  Appling 1 updated Stages to cache.

@ 30-05-2011 11:13:37 1 Updated Stages loaded.

0' 30052011 11:13:37  Load Data started. -

[] Auto Close when done

3.6 GSM connection to concentrators

One of the basic functionalities of eTools is to communicate with concentrators. This can be done
over different media. If the concentrators use GSM connections, the program needs a GSM master
modem connected to a COM port on the computer (Kamstrup A/S has master modems on stock).
In the Tools menu, under Options, the user selects to which COM port the master modem is
connected.
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e !

¢ Options =RRCIN X

Modem Settings |Eau:he Maintenance

Modem Settings
Modem Com Port : [E,OM-i -

Send modem initialization string

| Test Modem | | Soft Reset

Direct Com Connection Settings
Direct Com Port : [ -

| ok || cancel |

L= =

The COM port could be a physical or virtual COM port through COM port converters from e.g. LAN,
fibre, USB etc. The master modem has to be set to 9600, 8, n, 1.

eTools will set up a number of default parametres for the master modem. If you want to set up the
modem yourself (independently of the eTools application), clear the selection in the Send modem
initialization string check box. If in doubt, keep this option selected.

The user can test the connection to the modem. This function also gives a signal indication of the
master modem (this should be over 15.0). In addition, the user can reset the modem. This function
might be necessary if other programs have accessed the modem and changed its settings.

The concentrator can also be connected directly to the computer's COM port. Then the user has to
select to which COM port the concentrator is connected. This is especially intended for demo
purposes. This set-up requires a special RS232 cable.

3.7 User Management

Users with administrator rights are able to:

Create new users

Delete users

Grant or revoke administrator rights for a user
Reset passwords
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3.7.1 Create new users

Follow the steps below to create a new user of eTools:

1. Choose Tools menu = User Management = New.

81 User Management | (S |
Amy ° | Username John
aj@mycompany.com
Thomas E-rnail Js@mycompany.com
tm@mycompany.com
Full name John SmitH
Rachel
rh@mycompany.com [T 1s Administrator
Peter
pw@rnycompany.com Motes: |
Owen |

ot@mycompany.com

Megan
me@mycompany.com

Ryan
ry@mycompany.com

* @| {Zancel|

L ~

2. Enter user name, e-mail address and full name of the new user.

Note An e-mail address must be specified as the system automatically sends an e-mail
with user name and password to the new user.

3. Select Is Administrator if the new user should have access to the User Management
window.

The only difference between an ordinary user and an administrator is that the administrator is
able to create and delete users, reset passwords and grant these rights to other users.

4. Click Save.

3.7.2 Delete users

Follow the steps below to delete a user:
1. Choose Tools menu = User Management.

2. Inthe list of users to the left, select the user you want to delete.
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John
Js@mycompany.com

Amy
aj@mycompany.com

Thomas
@ mycompany.com

Rachel
rh@mycormpany.com

Peter
pwi@mycompany.com

Owen
ot@mycompany.com

Ryan
ry@mycompany.com

Fl

-

i - . | W
User Management Lglﬂu
-2 g

eTools

User name | Megan

E-rnail | me@mycompany.com

Full name Megan Evans
Is Administrator

MNotes:

3. Click Delete.

4. Inthe message that appears click Yes to confirm the deletion:

Delete User

3.7.3 Grant/revoke administrator rights

e e e @)

Follow the steps below to grant or revoke administrator rights for a user:

1. Choose Tools menu = User Management.

2. Inthe list of users to the left, select the user in question.
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=

Amy
aj@mycompany.com

Thomas
@ mycompany.com

Rachel
rh@mycormpany.com

Peter
pwi@mycompany.com

Owen
ot@mycompany.com

Megan
me@mycompany.com

Ryan
ry@mycompany.com

-

- ™
Uszer Management =k
-2 g ESEEEE

eTools

User name | John

E-rnail | Js@mycompany.com

Full name John Smith

.
'[ Is Administrator)

MNotes:

[New] [Save] [Camel] [Delete]

3. Select Is Administrator to grant administrator rights or clear the selection to revoke them.

4. Click Save.

3.7.4 Reset passwords

Follow the steps below to reset the password of another user:

1. Choose Tools menu = User Management.

2. Inthe list of users to the left, select the user whose password you want to reset.

Kamstrup A/S « 5512-760_GB_B1_09.2015_LHN
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eTools

[ =T

John User name | Megan
Js@mycompany.com

E-rnail | me@mycompany.com

Amy
aj@mycompany.com

Full name Megan Evans
Thomas

tm@mycompany.com Is Administrator

Rachel
rh@mycompany.com Motes:

Peter
pwi@mycompany.com

Owen
ct@mycompany.com

3. Click Reset password.

4. Inthe message that appears click Yes to confirm:

Delete User

Are you sure you want to reset the users password?

An email with a new password has been sent to me@mycompany.com.
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4 Import

eTools is a planning and analysing tool, and in order to view network units in the program, the user
has to import installation data on meters, routers and concentrators into the program. Installation
data is e.g. installation number, meter number, address information and coordinates.

4.1 Import wizard

Meters, routers and concentrators have to be imported separately. The user can import installation
data from Excel or text files to each stage into the project. eTools guides the user through the
steps of the import by means of an import wizard. In the File menu under Import, the user can
select to import meters, routers or concentrators.

In the following example, the file ImportMeters.csv is imported into eTools:

External Id; Meter Number;Street Name;Street Number; Longitude;Latitude;Area Name
1;11377320;Industrivej;38;10,00529741;56,070218;Area 1
2;11377321;Industrivej;40;10,00521701;56,0695993;Area 1
3;11377322;Industrivej;42;10,00634;56,0694119;Area 1
4;11377323;Industrive;j;44;10,00744862;56,069831;Area 1
5;11377319;Industrivej;46;10,00599758;56,0706128;Area 2

6;11377320;Error Dummy

etc.

1. Select stage

Mark the stage into which the units should be imported, and choose Import meters in the File
menu (marking the project imports the meters into the project without placing them in a stage).

2. Select the input file with installation data
If the file is supplied with header information, tick the checkbox Use first line as header.

The wizard automatically tries to detect the format and separator in the file, but this information
can be manually changed. Under DataPreview, the user can verify if the data is interpreted
correctly before proceeding by clicking Next.
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eTools

.

Welcome to the eTools Meter Import Wizzard.

This wizzard is used to import meters from excel or C5V files into the eTools
system.

Cancel ] | Previous | I Mend I | Run | | Finish
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Meter Import Wizzard

Impaort File
Filename:

C:'awprojectse ToolsMrunk\Docs  Manual Screenshats®

MeterimpontWizzard Screenshot Data csv

WL

Settings
CSVY Encoding Settings CSV Seperator Settings
Encoding Comma @ Semicolon Tab
Westem European (Windows) - Windows-1252 - Custom:
DataPreview
Exdemal Id Meter Number Street Mame Street Number Longitude L atitude
» KN 1377320 Industrivej 38 1000529741 | 56,07021
2 1137734 Industrivej 40 10,00521701 | 56,06955
3 11377322 Industrivej 42 10,00634 56.06941
4 11377323 Industrivej 44 1000744862 | 5606583
4] 1377315 Industrivej 45 1000599758 | 56,07061]
& 1377320 Emor Dummy

3. Data mapping

Next step is to map the data from the selected file into the data fields used in eTools.

Under Data Mapping Settings, the left column represents the eTools data field, and the right

column represents the input. For each row, the user maps the data field in eTools to the

column of data in the file. The field Externalld is mandatory and is the key for the import. If units
are imported with the same Externalld, data is overwritten by the wizard. This means that the

user can import installation points before the meters are exchanged in the field. When the

exchange has been done, the user can import the new meter number just selecting the same

Externalld. Any changes or extra data can be imported using the same Externalld. Other
eTools data fields are optional. If coordinates are imported, the user has to select if the

coordinates are in WGS84 or another format.

Overview of eTools standard data fields:
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ID Data field name |Description
1 Externalld Unique ID for the installation
2 MeterNumber The Kamstrup meter or router number
3 AreaName Name of the area of which the units are part
4 Longitude Coordinate longitude (WGS84 or other format)
5 Latitude Coordinate latitude (WGS84 or other format)
6 City City name
7 Postal Code Zip code
8 Streetname Name of the street of the installation
9 Streeetnumber Number of the house of the installation
10 Letter Extra street information like first floor information or A
and B
11 Data 1-4 Extra customer data field.
[ Meter Import Wizzard - .
Data Mapping Settings Cther Settings
Etools Column Mame File Column Name # | Coordinate format:
Extemal Id | Extemal Id - WGS 84 Format
Meter Mumber [Meter Mumber - 3
Area Mame [Frea Mame - L
Longitude [Lung'rtude -
e -
Data 1 | v
Data 2 [ * i
Data Preview
Bxdemal Id Meter Number Area Mame Longitude Latitude Strest Name
» KN 1377320 Area 1 10,00529741 | 56070218 | Industrive]
2 1137731 Area 1 10,00521701 | 56,0695393 | Industrivej
3 1377322 frea 1 10,00634 56,0694119 | Industrivej
i 4 11377323 Area 1 1000744862 | 56069831 | Industrivej
5 11377319 frea 2 10,00599758 | 56.0706128 | Industrivej
& 11377320 Emor Dummy
1 | 1]
Cancel ] [ Previous ] [ Mead

4. Start the import

After the mapping set-up, start the import into the database by clicking Run.

The wizard is now updating the data on the server.
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Mew units added: 0
Existing units updated: 0
Import emors: 0
Cancel ] [ Previous
5. Click Finish.

eTools

Meter Import Wizzard

6 of 6 rows validated.

Validation emors

| Row 7 has the same meter number as row 2
Row ¥ does not have a valid W&E584 longitude
Row 7 does nat have a valid WG584 latitude

IUnit Import Summany

Data is now imported into the eTools database.

4.2 Concentrator options

The import of concentrators will give more options due to the connection information needed for
each concentrator. This information could also be manually typed in at a later stage.

Overview of extra eTools concentrator data fields:

ID |Data field name

1 |ConcentratorNumber Number of the concentrator

2 |PhoneNumber Phone number of the GSM connected to the concentrator

3 |RemotePort Port selection on the remote GSM (2 ports are normally
available)

4 |IpAddress IP address of the IP module in the concentrator (e.g.
172.16.25.255)

5 |lpPort Port selection on the remote IP module (normally 1025)
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4.3 Import area build up

The communication units are always imported into the active stage in the Navigation View. If the
import file consists of area information, this can be imported into the program with the field
AreaName. The import function will create the area and place all units with the same name in that
particular area.
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5 Concentrator connection media

The eTools program must be able to contact each concentrator in the system. The program
supports different kinds of connection media. The connection is made from the client computer,
making it possible to communicate in a closed IP network. The currently supported media are:

e RS232 (direct COM port)
e GSM

¢ GPRS

o |IP.

To set up the connection media, right-click on the concentrator in the Concentrator View, and
select Edit Concentrator.

? /? Concentrator View a Meter View @ Router View Network View

Metwork Information
Concentrator Status = Concentrator Number  Connection Type  Phone Numb

&l = &l &l
N | Synchroniges = f f

"/ Not synch Create Concentrator SFRS 60258526
|/ Edit Concentrator

7% Delete Concentrators

(¢) Export Concentrators

In Editor, you can change all settings manually. The last fields in Editor regard the connection
settings. Changing the field Connection Type will enable the necessary input fields.
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r/’Edimr SR

BExtemal Id : cAd4dde-bcb6-484ealf-0ch2c 720855

Concentrator Mumber ;| 34730

Data 1:

Data 2 :

Data 3

Data 4 :

City :

Fostal Code :
Street Name

Street Mumber

Letter :

Coordinate Format : WGE5 84 Format -
Longitude : 10109526

Latitude 561525953

Connection Type : IGF'H,S Connection vJ
Remote Port IF‘nrt B "J
IP Address 10.12.16.44

IP Port: 4023

Phone Mumber : 23354608

5.1 RS232 (direct COM port)

Especially for test and demo purposes, it is possible to connect a concentrator directly to a COM
port on the client computer (it requires a special cable for the concentrator with a DIN SUB-9
connector). This makes it possible to make a demo network and test minor network functionalities.

See GSM connection to concentrators on how to set up the COM port.

5.2 GSM (data subscription)

If GSMis used as communication medium between the client computer and the concentrator, the
client computer must have a master modem connected to a selected COM port. The master
modem is used to establish connection to the concentrators. It will make a GSM data call, initiate
the concentrator tasks and automatically disconnect the line. The subscription of the SIM card
must cover data calls.
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Setting up the GSM connection is done by selecting GSM Connection as Connection Type.
The remote port is port A or port B on the GSM module to which the concentrator is connected.

The phone number must be entered without any spaces.

5.3 GPRS

A fast connection can be made by using GPRS as connection medium to the concentrators.

Using GPRS, the concentrators are online and no connect (call up) or disconnect sequence is
needed. The client must have access to the GPRS network. The GPRS connection transmits data
using the UDP Protocol. Setting up the GPRS connection is done by selecting GPRS Connection
as Connection Type. The remote port is port A or port B on the GPRS module to which the
concentrator is connected. The IP address must be entered in the format: a.b.c.d, where a, b, ¢
and d are positive numbers between 0 and 255 (e.g. 172.12.8.255). The IP port is the UDP port on
the module. Port 4023 is normally used if there is direct access between module and client
computer.

54 IP

The standalone concentrator can be supported with a built-in IP stack module. This module makes
it possible to communicate directly over IP cables using the TCP/IP Protocol. Please note that this
set-up requires IP access between the client computer and the concentrator. Setting up the IP
connection is done by selecting IP Connection as Connection Type. The IP address must be
entered in the format: a.b.c.d, where a, b, ¢ and d are positive numbers between 0 and 255. The IP
port is the port on the module (if direct addressing is possible) or the port used as firewall to
forward the module’s IP and port (if forwarding the port is necessary). Port 1025 is normally used if
there is direct access between module and client computer.

5.5 Testing the connection

When a new concentrator connection is entered and saved, the connection has to be tested by
making a ping to the concentrator. See Ping for further information about the ping task.

Kamstrup A/S ¢ 5512-760_GB_B1_09.2015_LHN 26/39



6 Project navigation

Navigation in the program is easy if the project has been built up correctly from the start. It is
important to use the terms stages and areas correctly in order to get a good overview of the
project.

6.1 Stages

The definition of a stage is a geographically isolated area with up to 2000 communication units. A
project can be divided into a number of stages, but the installation of communication units should
be done one stage at a time in order to finalise the network in continuous stages and move the
stages to the reading system.

6.2 Areas

A stage can be divided into smaller areas. The definition of an area is a minor geographically
isolated area within the stage with 1 to 600 communication units. An area is directly bounded to
concentrators, meaning that communication units in each area have to be able to communicate
with the concentrators placed in the particular area. Having two concentrators in each area will
result in a good network security increasing the number of communication links and making it
possible to backup failing concentrator connections.

The program is divided into different views for easy navigation.

Kamstrup A/S ¢ 5512-760_GB_B1_09.2015_LHN 27/39



B3 eTools - salg-dk-udv "- - =NaEn x|
File Tools View Help
Al
(=
— m——
[f View aad | F Concentrator View - [] Meter View | (@ Router View r Metwork View - X !De‘talls hilhs
E“%_ DB Stae 0 Network Information Address IArea Lezle
Q 4 X . INaran Electricety test wall
W 3830 Status Meter Number Meter Type WGSE4 Longitude WGESE Latitude Customer Long
B<> Heat test wall & _ & _ _ &l Concentrators
7 Tese 3¢ Unreachable 11377319 Unknown 0,0040%6 55,069544 10004056 J V!
@ Good 11377320 382162 10,004337 56,070037 10,004337 I Units
i Good 11377321 382162 10,006825 56,070371 10,006825 I Meters Routers
- - @ Good 11377322 382162 10,007017 56,070246 10,007017 I 4 0
Na\ﬂgatlﬂn il Good 11377323 382162 10,007166 56070127 10,007166 a ?
e @0
deo @0
X X0
o @0
Grid Total : 5 Total : 0
Notes:
Details
Tasks ~ 1
Concentrator Tasks
Tasks
] 1 b

6.3 Navigation View

This view is primarily used to switch between stages and areas. Selecting a stage, area or
concentrator will change the Grid view showing all communication units connected to the

selection.

Right-clicking in the view makes it possible to create stages.

Selecting stage and right-clicking makes it possible to edit stages and create areas.

Selecting area and right-clicking makes it possible to edit areas and show them in KML Viewer

(see KML Viewer export for further information).

The colours of the icons identify the synchronisation status of the concentrators in each area.
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an Stage Sync ok
Stage Changes made in stage but not moved to concentrator
Area Sync ok
Area Changes made in area but not moved to concentrator

Concentrator Sync ok

Concentrator Concentrator not updated

1] O@

Concentrator Concentrator not yet contacted

-
e,

"t

7 Concentrator Error (outdated firmware or similar errors that eTools cannot correct)

The synchronisation status will change when the user is initiating different tasks towards the
concentrators.

Moving units between stages and areas can easily be done by selecting the units in the Grid view,
dragging them to the area or stage in which you want them to be placed, and selecting Copy or
Move. Copy means that the units remain in the old stage/area. Move means that the units are
removed from the old stage/area.

6.4 Grid View

The Grid view presents the communication units in the network. The view is linked to the
Navigation view and only shows units in the selected area, stage or project. It is divided into four
views:

1. Concentrator View

2. Meter View

3. Router View (standalone routers)
4. Network View.

If the communication unit is a meter with integrated routing, it is shown in the Meter grid. If the
router is a standalone router, it is shown in the Router grid.

The views 1, 2 and 3 will show all information regarding each unit in the network in a combined
grid. The grid is built in two levels:

" Concentrator View . [g] Meter View | () Router View Metwork View

Metwork Information Address *— LEVEI 1

Status Meter Number  Meter Type VIGSS4 Longitude  WGSB4 Latiude i | avel 2

Level 1 indicates the type of information, Level 2 the detailed information.

The grid offers various filter and sorting possibilities:
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‘¥ Concentrator View aMeterView@ Router View

MNetwork Information

Meter Mumber

11377315
11377320
1137731
11377322

eTools

Meter Type

3321e2
332162

Metwark View * X
Address
WiES584 Longitude WniG584 Latitude Customer Longitude Custc

|~ (&l &l

10,004056 10004096 56,06
10,004337 10,004337 56,07
10,006825 10,006825 56,07
10,007017 10,007017 56,07

Customising
the Grid view,
enabling and
disabling each
field in the grid

Sorting
- falling
- ascending

Filter options:

>

<2

begins with
ends with etc.

Clear
filter options

These possibilities make it possible to focus on the exact meters, types, groups, streets, network

quality etc.

6.5 Network View

To evaluate the communication path in the network, eTools provides a Network view. The view
shows how the concentrators are using each router and meter for communication. The view is

based on the concentrator’s netlist. Therefore, the view is only possible when a netlist has been
imported into or retrieved from the program (see Retrieve netlist for further information).
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:\? Concentrator View J Meter View Q Router View - Network View - X

Search for unit

B!
) GETETHY (253)
B §310253 (250)
B BE0TITZ (247)
-mm GEOTIET (246)
- 5507362 (232)
— 7219 (244)
w— 0245 (245)
o BE0TIE5 (247)
-mm GE07I73 (246)
e 5466500 (239)
— GAGE516 (238)
= BETET5T (250)
— 7321 (249)
— 0244 (249)
) 45344 (254)
— GE7E75S (253)
— 7320 (253)
) GEOT364 (255)
— 5507368 (254)

Link quality Description
- Good Signal level is good and normally very stable
Medium Signal level is acceptable, but can have power cuts
- Bad Signal level is bad and will probably have low performance

The number in parentheses, e.g. (253), is a quality stamp for each meter. The number starts at
256 on the concentrator and will drop down to 0 depending on the signal quality and number of
communication links used. Evaluating the numbers can help find the worst links in the network and
view how many other communication units are dependent on each link.

This tool is very effective to spot weak links in the network that might be important for several
meters.

6.6 Details View

The Details view shows detailed information about stages, areas, concentrators, routers and
meters. The view is dependent on the selected unit in the Navigation or Grid view.

Information about stages and areas can be added as customised notes. Right-click on the stage or
area in the Navigation view and select Edit. The user can now type in specific information. The
view also counts the total number of units in the selected stage or area (e.g. Meter # = 180).
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Details -~

Ares Details

MName Electricety test wall
Concentrators

1

LInits

Meters Routers
all 4 @0
o @0
o @0
A1 Xo
o 0
Total . & Total : 0
MNotes:

6.7 Task View

The Task View provides possibilities to start different tasks in the concentrators. The tasks will be
started on the concentrator visible in the Details view. Each task will start an operation in the

concentrator that will block the concentrator for a period of time. For a detailed description of each
task, see Concentrator tasks.
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7 Concentrator tasks

The task provided by the program starts operations in each concentrator. With these tasks it is
possible to build up the network and let the concentrator analyse the signal level of each meter.
The concentrator stores its network information on the netlist. This netlist controls all
communication in the network, and most of the tasks concern operations where the concentrator
alters or delivers information on/from the netlist.

7.1 Ping

The ping task is primarily used to test the connection to the concentrator. If the concentrator
response is OK, the concentrator is not doing any mayor operations like readings or network
updates. The ping task updates the detailed information in the program concerning the
concentrator.

7.2 Retrieve netlist

The Retrieve netlist task imports the netlist from the concentrator into the program. After having
retrieved a netlist from a concentrator, the program will update all status on each meter connected
to the actual concentrator, making it possible to analyse the network. The program will combine
information from all netlists in the project and will show the best quality of each meter in the grid.

7.3 Upload area and reset

When an area has been specified in the program, the task Upload area and reset clears the
concentrator’s net list and starts an operation in the concentrator that scans for all meters in the
area. This task will take some time as the concentrator is building up the network list according to
the link information from each router in the network. The task should be used as the first step of
evaluating an installed network, and if major changes have been made in the area (e.g. moving
many meters between areas).

7.4 Update network links

This task will try to optimise the links in the concentrator. The task is used if the area is not
changed, but major corrections have been made since the last reset (e.g. placement of important
antennas in the area). The task updates all links and scans all meters for better signals.

7.5 Synchronise

If smaller changes have been made in the area (e.g. adding or removing 3-5 meters), it is possible
to synchronise the information in the program with the concentrator. This task will remove and
scan meters individually. It will stop the scan when the meter is found with reasonable signals. It
will focus on getting contact with the actual meter, not using it for optimising other meters’
communication. The synchronisation will also automatically start a scan for meters that are
“‘unreachable” in the network, trying to get contact with all meters. This means that the task can
also be used if smaller corrections in the installation (e.g. antenna adjustments) have been made
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to get contact with a missing meter.

7.6 Timing in the network

Starting tasks in the concentrators will sometimes start communication in the network that can
influence other concentrators operating concurrently in the same geographical area. The user has
to evaluate which concentrators might influence each other and only start tasks on one
concentrator at a time in the same geographical area. The duration of each task varies and will
depend on the number of meters in each area. The synchronisation task starts background
operations that will be paused if the concentrator is used for readings or other tasks.

The normal duration each task is:

Task Task type Task duration

Ping No network communication|Immediately

Retrieve netlist No network communication|Immediately

Upload area and Main communication Max 2 minutes per router in the network

reset

Update network links [Main communication Max 2 minutes per router in the network

Synchronise Background Dependent on the network and number of
communication changes.

7.7 Battery systems

Be aware that operations initiating communication in the network will use battery in all the battery
components that can be reached. The user has to minimise the number of resets in order to keep
the battery level high for future readings. Normally, keeping the number of resets/updates below 10
pcs. should not influence the specified lifetime of the battery network. In addition, using the
synchronisation task will use battery and should be limited.

One way of minimising the communication is to wait to initiate the tasks until all components in the
area are installed. Another important issue is to install all components according to the specified
guidelines.
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8 KML Viewer export

Each area can be viewed in the geographical view program KML Viewer. eTools exports KML files
consisting of communication units and links in the network.

] e e
EI@ mEnergy | |

®

=S Heelweg | 4 Edit Area

@ | de Keilzd 2¢  Delete Area

38 Julianastr,

- Kalverweis I.,E-;:_’-_& Generate and open Kml file in default Kml viewer

F-4gp Meibrink

= Montferland

=% Oldershove |

4@ Oldershove Il

4@ Terborgseweg

- Weversstraat

Right-click on the area and select Generate and open KML file in default KML Viewer. This
starts up KML Viewer (if it is not already started) and import the KML files, making it possible to
view the area.

1 — e —
& Google Earth - — — EIEIQ

File Edit View Tools Add Help

¥ Search

Fly To | Find Businesses I Directions |

Fly to e.g., Reservoir Rd. Clayville, NY

=l Q

v Places

g' My Places

=] @ Temporary Places

N = =) Electricety test wall
Ve

= ER= Good

- M@ w3

- ¥ @ waskn

I - M@ ummee
SAFil= BVEyyErE]

- Medium

- M Bad

= M9 Unreachable
- 14 1377319
i) Mot uploaded

WP e

Google
| &

e

» Layers Earth Gallery »» Imagery,Date: 1/1/20065 2B 2005 lat 580699587 lon 10! 3 v B Eyealt 392m

‘F -
.
TR

In KML Viewer, the communication units are grouped in quality segments. This makes it possible
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to easily switch on and off different groups and identify and focus on problem areas.

Selecting a unit on the map makes it possible to get information about the unit, and its link quality.
Through this menu, it is also possible to show actual links in the network from the unit to each
concentrator. Be aware that deleting the links is done manually by selecting the link in KML Viewer
and deleting it.

8.1 Requirements

To be able to export to map applications, KML Viewer must be installed on the client computer.
Some computers prefer to use DirectX or OpenGL when using KML Viewer. Please try both
options.

The map application must be configured to allow access to local files from placemark balloons.

| 3D View | Cache I Touring | Mavigation | General |
Display Email Program
Show tooltips () Microsoft Qutlook
[ Show web results in external browser (71 Use my Gmail account
Building highlights @ Letme choose each time I send an email
Language settings Start up tips
Language |Englizh (US) |E| |:| Show start up tips
Usage Statistics Placemark balloons

[] Send usage statistics to Google (/| Allow access to local files and personal data

KML Error Handling

@ Silenty accept all unrecognized data
(7 Show prompts for all errors

(71 Abort file load on any error

Restore Defaults QK ][ Cancel H Apply ]
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9 Project handling

The basic function of the tool is to administrate communication units in stages and areas and
move this information to the concentrators in the network. The main steps for handling a normal
project could be:

e Create a new stage in the project

e Import meters, routers and concentrators

e Build up the areas

e Upload area and reset each concentrator (be aware of concurrence)
e Retrieve net list from concentrators

e Evaluate result

e Fixunreachable and bad units in the network

e Synchronise or update the network

e Move finalised areas to the reading server for test readings.

When installing the communication units, it is important to follow the installation guidelines given by
Kamstrup A/S. Experience shows that not following the guidelines will result in extra work at a later
stage, having to visit the customers more than once. In some cases, it might be necessary to
adjust the guidelines to local or special cases.

Fixing and adjusting the network can be done in several ways, e.g. moving meters to another area,
using extra routers or concentrators, optimising the placement of the antenna etc. These
adjustments should be minor if the guidelines are followed.

9.1 Moving meters to the reading system

When the quality result is satisfactory, the area is ready to be moved to the reading system. A
satisfactory result should consist of at least 90 % good signals. A few meters might have medium
or even quality, but this might be OK for stable readings. The reason for this is that performance is
not 100 % dependent on signal levels. An example is that a “line of sight” radio link is very stable
even with a low signal level. A reflected radio link is more dependent on the signal level. Therefore,
an area should always be finalised with stability readings from the actual reading system.

For systems using Kamstrup CDAPIl and AMR Manager, the area is moved by adding the
concentrators to AMR Manager (use the function Add entry point). When the concentrators have
been added and the net list has been downloaded to AMR Manager, the meters are ready for the
reading system to read. Please refer to the manual for the exact reading system. After having
moved the area, the user of the reading system uses AMR Manager to maintain the system.
eTools could also be used to maintain the network, but as this will require a parallel set-up of the
reading system, it is necessary to evaluate when communication with the network is possible.

Separating eTools and the AMR system functions makes it possible to divide the work into a
project. One company could be responsible for building up the network with eTools, and another
could own the AMR system when the system is ready for readings.
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10 Additional information

This chapter provides you with an overview of where to find additional relevant information.

What do you want to do?

e Access the eTools online help
e Contact Kamstrup online support
e See news update on eTools or other Kamstrup products

10.1 Accessing the eTools online help

You open the eTools help window by pressing F1 or by choosing Help menu = Manual:

Bl eTools 55
File  Teols View | Help

%1 |'1'E' Manual F1
@ Quick Start e
.| FRelease Notes L on
@ About trator

no koordinates ' E_.
7 Mot synchroni
| et 4 Synchronized

10.2 Contacting Kamstrup support

You can contact Kamstrup support in one of the following ways:

Service desk:
https://servicedesk.kamstrup.com/

Online system support:
https://support.kamstrup.dk/

Email:
Support.systems@kamstrup.dk

Telephone:

+45 8993 1110

Monday - Thursday from 8 am to 4 pm.
Friday from 8 am to 2.30 pm.
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10.3 eTools Manager news update

To obtain the latest information about eTools and our other products, visit our website:
www.kamstrup.com.

If you have any further questions, do not hesitate to send us an email.

Kamstrup A/S
Industrivej 28, Stilling
DK-8660 Skanderborg

TEL: +45 89 93 10 00
FAX: +45 89 93 10 01
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